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For safety reasons, this manual indicates items requiring particular attention with 
the following marks.

Caution
This is a warning against anything which may cause injury to people if the 
warning is ignored. You are informed about what you must or must not do in order 
to reduce the risk or injury to yourself and others.

Notice
This is a warning against anything which may cause damage to the vehicle or its 
equipment if the warning is ignored. You are informed about what you must or 
must not do in order to avoid or reduce the risk of damage to your vehicle and its 
equipment.

IMPORTANT INFORMATION ABOUT THIS MANUAL

Market: Canada



TOYOTA — DASH CAMERA Page 2

English

Caution
• While driving, the driver must not insert or eject the SD memory card. Doing so 

may cause an accident from being distracted.  
If these operations are necessary, be sure to park the car in a safe place.

• NEVER drive dangerously on purpose in order to check that this equipment 
detects the impact properly. Noncompliance with this instruction may result in 
accidents.

• Do not disassemble or modify this equipment. Noncompliance with this 
instruction may result in traffic accidents, fire and/or electric shock.

• Do not allow water or foreign objects to enter the internal parts of this 
equipment. Otherwise, the equipment may emit smoke and/or catch fire and/or 
electric shock may result.

• If abnormal conditions occur, i.e. foreign objects enter this equipment and/or it 
is exposed to water and/or emits smoke and/or a strange odor, turn off vehicle 
immediately and contact the dealer from whom you purchased the equipment. 
Continuing to use it in these conditions may result in unexpected accidents, fire 
and/or electric shock.

• Continuing to use it in these conditions may result in unexpected accidents, fire 
and/or electric shock.

• Do not damage the camera cable. Any holes in the camera will provide a point 
of entry for moisture and water. Noncompliance with this instruction may result 
in fire, electric shock and/or malfunctions.

• During a thunderstorm, do not touch the camera. Danger of electric shock may 
result from lightning strikes.

• The product packaging contains a plastic bag. NEVER put a plastic bag over 
your head or mouth. Failure to do so may result in serious accidents and/or 
death by suffocation. Keep plastic bags away from children.

SAFETY PRECAUTIONS
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Notice
• For your safety, when changing the location of this equipment, consult the 

dealer from whom you purchased the equipment for removing and re-installing 
the equipment. Expertise is required for removal and installation of the 
equipment.

• Do not put your hands and/or fingers into the card loading slot. Noncompliance 
with this instruction may result in injury.

• Do not use this equipment except for in-vehicle use. Otherwise, the equipment 
may emit smoke and/or catch fire, and/or electric shock and/or injury may 
result.

• Do not apply a strong shock to this equipment. Do not drop it. Do not put heavy 
objects on it. Noncompliance with this instruction may result in fire and/or 
malfunctions.

• If exposed to direct sunlight surface of camera may become hot.

• If the equipment is dropped or the outer case is damaged, turn off vehicle and 
contact the dealer from whom you purchased the equipment. 
Continuing to use it in this condition may result in fire and/or electric shock.

• After installing this equipment, be sure to configure the calibration setting. 
Otherwise, the equipment may fail to detect the impact properly, it may work 
improperly and/or it may fail to work even if the vehicle receives impact. 

SAFETY PRECAUTIONS
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Privacy Warning
• A microphone is built in this Dash Camera and sounds and voices in the 

vehicle are saved in the SD card. Recording function is turned off at the factory 
shipment. Recorded sound data might infringe privacy rights of passengers 
inside vehicle. Request approval of passengers and comply with federal and 
state laws when microphone is on. You are able to turn off this function if 
necessary. Refer to the detailed description in page 21.

• Images or video shot and uploaded to a social media site may infringe the 
privacy of pedestrians or other parties. We are not liable for images or video 
that infringe on the privacy of third parties, should they be shot and uploaded to 
a social media site.

Warnings about Video Recording
• The purpose of this Dash Camera is to record the conditions when a vehicle 

is driven. Do not use the Dash Camera for mischief or any other improper 
purposes.

• One of the purposes of this Dash Camera is to provide proof in the case of an 
accident. However, its effectiveness as evidence is not guaranteed.

• We are not liable whatsoever for any damages that arise, such as from the 
video failing to record or a recorded file being damaged, nor for any losses, 
such as the Dash Camera being damaged or from use of the Dash Camera.
Videos may not be recorded or protected under the following conditions.
(1) If a micro SD card is not inserted in the Dash Camera.
(2) If the micro SD card is ejected from the Dash Camera.
(3)  If anything other than a genuine micro SD card or the one provided with the 

Dash Camera is used.
(4)  If recorded videos are overwritten (deleted) by newly recorded videos.
(5)  If the Dash Camera or the micro SD card is severely damaged due to a 

vehicle collision event or immersed in water.
(6)  If the power supply cord from the battery to the Dash Camera is broken or if 

the battery is damaged due to a severe accident.
(7)  If an impact is less than the set value (parking surveillance function).
(8)  If camera visibility is extremely low due to windshield condensation or 

heavy precipitation.
(9)  If the Micro SD card memory has become corrupted, you may lose data or 

may not be able to record. Micro SD cards have limited life and may require 
replacement. 

IMPORTANT INFORMATION
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Videos during an impact event may not be recorded or saved during the 
following cases:
(10)  If your vehicle collides at low speed, or if another vehicle collides with yours 

at a relatively low speed.
(11)  If a part of your or the other party’s vehicle is hit in a part designed to 

mitigate impact.
 *  (10) (11) Bumpers, doors, spare tire cover, etc. absorb shock, so the actual 

impact may be smaller than it appears.
 *  (10) (11) Accidents in which the impact is so slight that the air bag does not 

activate may not be detected.
(12)  If the other party’s vehicle has relatively less weight than to your vehicle, or 

if your vehicle collides with a person or a bicycle.
(13)  If the contact with the other party's vehicle is at an angle rather than a direct 

impact.
 *  (12) (13) If the other party’s vehicle is relatively lighter in weight (vehicle 

vs. person, vehicle vs. bicycle, etc.), or if the other vehicle rolls over, the 
shock of the collision is mitigated, and the shock to your own vehicle is 
lower.

(14)  If sudden braking is applied on a snowy or frozen road.
  *  There is little friction between a vehicle’s tires and the road when it is 

snowy or frozen. Consequently, the vehicle slips at even the slightest 
impact, which is difficult for the G-sensor to detect.

(15) If the impact is below G-sensor sensitivity settings.
(16)  If there is a problem in the installation of the Dash Camera, such as 

the body of the Dash Camera not being fixed, or if the calibration after 
installation is incorrect.

• This Dash Camera is used for recording video; however, it is not guaranteed 
that it will always be able to confirm a traffic signal. Environmental factors may 
prevent confirmation of the traffic signal. In that case, judge the traffic signal 
from the video before and after and from vehicles around it. We bear no liability 
whatsoever for conditions in which a traffic signal cannot be confirmed.

• LED traffic signals flash faster than the human eye can detect, so when video 
is shot with the Dash Camera, it may appear to be blinking. If the traffic signal 
is not captured on video, make a judgment about it based on video before and 
after and from vehicles around it. We shall bear no responsibility whatsoever if 
video cannot capture an LED traffic signal device.

IMPORTANT INFORMATION
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• This video recorder is constantly recording while ignition is on. When the micro 
SD card is full, older videos are deleted and overwritten by new ones in the unit 
of "Chapter" files (except event-protected video files). The Dash Camera has 
a function that protects up to five videos recorded when it detects the ACTION 
button has been pressed. If the number of videos reaches the maximum 
number, protection of older videos is released, and they become subject to 
deletion. When the data is important, such as in the case of an accident, turn 
off the ignition key of the vehicle as soon as possible. Eject the micro SD 
card and save the video on a personal computer or save the video to your 
smartphone using the smartphone application. 

• If you wish to keep a recorded video, copy the video to your computer, upload 
to social media site, etc. from a smartphone, or save in another way. We are 
not liable for corrupted files that may occur when saving image or video files 
that you have shot to a computer.

Cautions about Operating and Handling the Dash Camera
• The driver should not eject/insert the micro SD card, or operate a smartphone 

while driving. Doing so may cause an accident from being distracted. If these 
operations are necessary, be sure to park the car in a safe place first.

• Do not park or stop the car illegally in order to use the Dash Camera.

• Do not touch the Dash Camera with a bare hand if it has been sitting in direct 
sunlight during the summer. The Dash Camera may be hot and cause a burn.

• Do not spray any type of cleaner or pour water on the Dash Camera.  
The double sided tape may fail and allow the Dash Camera to fall.

• Videos recorded when there is water on the windshield or when it is dirty may 
result in unclear images.

• When cleaning the windshield, do not pull on the Dash Camera or the cord 
with excessive force. The Dash Camera may come off. (Please consult your 
dealership if it comes off).

• This Dash Camera acquires date and time via GPS. If the date, time, and/or 
location of the recorded data is wrong, or if the location fails to change, consult 
the dealership.

• When the vehicle battery is removed, the time is reset to the correct time 
at the next startup, when GPS data is received. After the battery has been 
reconnected, confirm that the GPS data has been received correctly by 
checking the recorded video file name and the location.

IMPORTANT INFORMATION
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• Due to the properties of the camera’s lens, people and objects on the screen 
may appear to be in a position and distance which may differ from their actual 
position and distance. 
Blooming phenomenon: When a bright object (sun, headlight, etc.) is recorded, 
white saturation occurs around the light.

• Do not scratches to camera surface may allow humidity or moisture inside, 
causing malfunction, fire, and/or electric shock.

• Do not touch the camera lock dial. Doing so may prevent it from recording in 
the required angle.

• Do not wipe the Dash Camera with alcohol, benzene, thinner, gasoline, or 
other volatile chemicals. Doing so may cause deformation, deterioration, or 
other damage.

• When the camera lens is dirty, lightly wipe the lens with a soft cloth soaked in 
water. Rubbing the lens roughly with a dry cloth may cause scratching.

Handling SD Cards
• When using a micro SD card for the Dash Camera, always use a genuine 

micro SD card or the micro SD card provided with the Dash Camera. Micro 
SD card provided with the Dash Camera is industrial grade with longer life 
compared to other commercially available micro SD cards. The Dash Camera 
may not operate properly if another type of micro SD card is used.

• Do not save data other than that recorded by this Dash Camera to the micro 
SD card. Otherwise, videos may not be recorded properly.

• Confirm that the Dash Camera is off (LED is off) when inserting/ejecting the 
micro SD card. Do not insert/eject a micro SD card while the Dash Camera is 
running. Doing so may damage the micro SD card.

• Never eject the micro SD card while the Dash Camera is accessing the card 
(LED is on or blinking). Doing so may damage not only the micro SD card but 
also the Dash Camera itself.

• Do not insert a hand or a finger in the micro SD card slot. Doing so may result 
in injury.

• Do not insert any foreign material into the card slot for the micro SD card. 
Doing so may cause a fire or electrical shock.

• The micro SD card may be hot right after the power is turned off. Be careful not 
to touch with bare hands.

IMPORTANT INFORMATION
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Video recorded on this Dash Camera may be viewed on a computer that meets 
the following specifications.

 ● Personal Computer Requirements

Windows Computers Macintosh Computers
OS Windows 7, 32-bit or 64-bit

Windows 8/8.1, 32-bit or 64-bit
Windows 10, 32-bit or 64-bit

Mac OS X 10.9 (Mavericks) or later

CPU Processor with 2 GHz or higher, 
CPU with Intel® Core™ i3 or later version

Intel® Core™ 2 Duo or higher

Memory 2 GB or more  
(Recommended more than 4 GB)

2 GB or more

Display 1024 × 768 (XGA) pixel or higher, High 
Color (16 bit) or higher

1280 × 800 or higher

Audio PCM sound reproduction function 
compatible with Windows

Standard built-in Macintosh 
computer audio

Other • Internet Explorer 9.0 or later version
• Accessing the micro SD card is possible 

via a card reader.
• Internet connection environment (for 

display of travel position via Google 
Maps)

• Safari 9 or later version
• Accessing the micro SD card is 

possible via a card reader.
• Internet connection environment 

(for display of travel position via 
Google Maps)

NOTE
• System requirements may change. Refer to following URL for latest minimum 

specifications. 
http://www.e-iserv.jp/top/driverecorder/DashCamViewer/index.html?lang=en

• The video image may be distorted and/or the audio interrupted on some 
computers. If this happens, close the viewer software and restart it to view the 
video.

 ● Smartphone Requirement

In order to see the video recorded with this Dash Camera on the viewer software 
of a smartphone, a device that meets the following specifications is required. 

Apple • Mobile device: iPhone 4 or later 
• Operating system: iOS 7.0 or later

Android • Mobile device: Android smartphone 
• Operating system: Android OS 4.0 or later

*   iPad is not supported.

NOTE
• For the latest application information, please check the App Store or Google Play.

PLAYING BACK OF MOVIE FILES

Market: Canada



TOYOTA — DASH CAMERA Page 9

- United States of America

FCC ID: BABFT0112A

CAUTION: Radio Frequency Radiation Exposure
This equipment complies with FCC radiation exposure limits set forth for an 
uncontrolled environment and meets the FCC radio frequency (RF) Exposure 
Guidelines. This equipment should be installed and operated keeping the radiator 
at least 20 cm or more away from person's body in normal use position.

Co-location: This transmitter must not be co-located or operated in conjunction 
with any other antenna or transmitter.

This device complies with part 15 of the FCC Rules. Operation is subject to the 
following two conditions: (1) This device may not cause harmful interference, and 
(2) this device must accept any interference received, including interference that 
may cause undesired operation.

FCC WARNING
Changes or modifications not expressly approved by the party responsible for 
compliance could void the user's authority to operate the equipment.

- Canada

IC: 2024B-FT0112A

This device complies with Industry Canada's licence-exempt RSSs. Operation is 
subject to the following two conditions:
(1) This device may not cause interference; and
(2)  This device must accept any interference, including interference that may 

cause undesired operation of the device.

CAUTION: Radio Frequency Radiation Exposure
This equipment complies with IC radiation exposure limits set forth for an 
uncontrolled environment and meets RSS-102 of the IC radio frequency (RF) 
Exposure rules. This equipment should be installed and operated keeping the 
radiator at least 20 cm or more away from person's body (excluding extremities: 
hands, wrists, feet and ankles).

GOVERMENT REGULATIONS
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• App Store is a service mark of Apple Inc., registered in the U.S. and other 
countries.

• Apple and iPhone are trademarks of Apple Inc.

• iOS is the name of the OS of Apple Inc.

• Apple, Macintosh and Mac OS are trademarks of Apple Inc., registered in the 
U.S. and other countries.

• Google Play is a trademark of Google Inc.

• Google Maps is a trademark of Google Inc.

• Android is a trademark of Google Inc.

• Wi-Fi® and Wi-Fi Direct® are registered trademarks of Wi-Fi Alliance. 

• microSDHC Logo is a trademark of SD-3C, LLC.

• Windows 7, Windows 8, Windows 8.1, and Windows 10 are registered 
trademarks of Microsoft Corporation in the United States and/or other 
countries.

• Other company names and product names used in this manual are either 
registered trademarks or trademarks of their respective company.

TRADEMARKS
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 ● About Open Source Software included in the dash camera

This dash camera includes certain open source or other software originating from 
third parties that is subject to the GNU General Public License version 2 (GPLv2) 
and different copyright licenses, disclaimers and notices. The source code and 
the license information of software licensed under GPLv2 and different copyright 
licenses, disclaimers and notices are distributed at the website below.

http://www.e-iserv.jp/top/driverecorder/DashCamViewer/index.html?lang=en

 ● About Open Source Software included in the PC viewer software

This viewer software includes certain open source or other software originating 
from third parties that is subject to the GNU General Public License version 2 
(GPLv2) and different copyright licenses, disclaimers and notices. The source 
code of software licensed under GPLv2 and different copyright licenses, 
disclaimers and notices are distributed at the website below.

http://www.e-iserv.jp/top/driverecorder/DashCamViewer/index.html?lang=en

OPEN SOURCE SOFTWARE INFORMATION
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The Toyota Genuine Dash Camera is designed to provide a safe and memorable 
driving experience in your Toyota vehicle. Safely record the on-goings of the 
open road while keeping your eyes on the road. Never miss a moment in motion; 
capture it! The Toyota Genuine Dash Camera will also allow you to record the 
surroundings of your vehicle while it is parked.

Personal safety, as well as security for your Toyota vehicle, is our top priority. 
The Dash Camera is safely installed on your front windshield. The camera will 
automatically save and record data after impact in the event of a crash. The 
camera automatically starts when the ignition power is on. When the vehicle is 
stationary, you can access videos and change the settings via your smartphone 
app or on your computer by inserting the camera’s microSD card.

The Dash Camera features a number of different recording modes:

The Infinite Loop: With a high quality, industrial grade micro SD card, the 
footage will continuously record up to 170 minutes of 1080p HD footage 
(Standard mode, Bit rate: 6.2 Mbps) in an infinite loop, allowing you to capture 
every moment of your drive. The accompanying software will allow you to save 
any footage to your smartphone using Wi-Fi data transmission or simply take the 
microSD card out of the camera to save your files to your computer. 

Incident Recording: With the help of the G-sensor impact detection, the footage 
will automatically lock on the microSD card for retrieval at a later time and you will 
not have to worry about anything else but the safety of everyone involved. 

Parking Surveillance: Shortly after impact, the 
Dash Camera will record up to 60 seconds following 
the impact and the file will be locked on the microSD 
card.  

Interesting event recording: At the push of a 
button, automatically save 12 seconds before and 
8 seconds after an event.

Adventure Mode: With Adventure mode, you 
can manually save up to an hour of footage at the 
highest quality video setting. 

For any questions about your Genuine Toyota Dash Camera, please consult your 
Toyota dealer.

Thank you for purchasing a Toyota Genuine Accessory. 

INTRODUCTION
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(7)

(8)

(4)

(5)
(6)

(1)

(2)
(3)

(9)

(1) ACTION button

• Protects the recording video. (Event protection)  
(See page 19.)

• Press and hold for more than 1 second, the Adventure 
mode starts/stops. (See page 20.)

• Stops the error sound.

(2) ERR LED (Amber) Indicates that the Dash Camera has a problem when it is 
on or blinking. (See page 14.)

(3) REC LED (Green) Indicates that the Dash Camera is ready for recording when 
the LED is on. (See page 15.)

(4) Micro SD card slot Insert the micro SD card to be used into this slot.

(5) Microphone Records audio.
The microphone is built in the Dash Camera.

(6)
Audio recording on/
off switch Switches on/off the audio recording. (See page 21.)

(7) Side cover The camera is adjusted to an appropriate angle during 
installation to the vehicle. Do not touch the cover.

(8) Camera Records the video images.

(9) Wi-Fi password Default Wi-Fi password / Serial number.
The same password written is in the back cover page.

PARTS AND FUNCTION DESCRIPTION OPERATION
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This Dash Camera has a function to notify its condition with an ERR LED (amber), 
REC LED (green), and a buzzer. Symbols for LED conditions are as follows.

: On : Quick blinking

: Off : Slow blinking

1  Abnormal Notification

This section describes the conditions, possible causes, and measures in case of 
abnormal conditions.

Buzzer ERR LED
(amber)

REC LED
(green)

Cause Measure

Continuous 
long high-tone 
beeps
*1, *2

A micro SD card is not 
inserted.

Insert a micro SD card.

Alternate long 
high-tone 
beep and long 
low-tone beep
*1, *3

Hardware abnormality
The Dash Camera cannot 
record a video because 
of camera or image 
processing problems.

Turn off the vehicle 
and turn it on again. 
If it cannot be solved, 
consult the dealership 
where you purchased 
the Dash Camera.

The micro SD card has a 
problem or not formatted.

Format the micro SD 
card. (See page 47.)

(Silent)  *4
or

Videos are recorded, but 
the Dash Camera is not 
working correctly with 
malfunction. (Problems 
of audio, timestamps, 
G-sensor, etc.)

Please consult the 
dealership where you 
purchased the Dash 
Camera.
* 5

Continuous 
long high-tone 
beeps
*1, *3

 *4
or

Calibration not 
conducted.

Perform the calibration. 
(See page 18.)

After the calibration 
is set, the installation 
location and direction are 
changed.

*1:   When the ACTION button is pressed, the buzzer stops. However, take note that the 
Dash Camera is not working.

*2:   The volume of the buzzer can be changed. The default volume setting is <High>.  
(See page 39 and 57.)

*3:   The volume is not adjustable.
*4:   It varies depending on the recorded condition of videos and audios.
*5:   After the vehicle battery is removed, the date and time data are returned to the default 

value. From the time of first activation after the GPS signal is received, the date and 
time data are corrected to the accurate data.

NOTIFICATION BY LED INDICATOR AND BUZZER
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2  Normal Notification

This section describes LED and buzzer conditions while the Dash Camera is 
working correctly.

 ● LED condition

ERR LED
(amber)

REC LED
(green) Description

Power off.
Nothing is recorded when the Dash Camera power is 
off.

Blinking in 0.5 sec. 
intervals

Power on or starting.
No video or audio is recorded while the Dash 
Camera is starting.

Recording video. Audio recording depends on 
microphone switch setting. (See page 21.)

Blinking in 1 sec. 
intervals

Blinking in 1 sec. 
intervals

Communicating data with a smartphone by the Wi-Fi 
connection.

Blinking in 1.75 sec. 
intervals

Recording video in the Adventure mode. Audio 
recording depends on microphone switch setting. 
(See page 21.)

NOTE: During a power down process, the REC LED (green) lights up and then blinks.

NOTIFICATION BY LED INDICATOR AND BUZZER
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 ● Buzzer

Buzzer Description

Single short and 
high-tone beep

Started normally.

Single short and 
high-tone beep

Protection of recorded video has been 
initiated (event protection).

Three short beeps Started up/ended the Adventure mode.

Two short beeps A shock was detected during traveling.
The recorded video is the subject of 
protection against overwriting.

Six continuous long 
high-tone beeps 
(twice)

A shock was detected while parking. 
(Parking surveillance function)
User will be notified by buzzer on next 
ignition ON.

One long low-tone 
beep

The ACTION button was pressed while the 
recorded video was protected (Automatic 
event protection).
Manual event protection function is invalid 
while the event is being protected.

NOTE: The volume of the buzzer can be changed. (See page 39 and 57.)

NOTIFICATION BY LED INDICATOR AND BUZZER

Pi

Pi

Pi

Pi

Pi

Pi

Pi

Pi

Pi

Pir

Pir

Pir Pir

Pir

Pir

Pir

Pi

Pu–
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The Dash Camera records video, audio, location data from GPS into the micro 
SD card while driving. With the viewer software dedicated for this Dash Camera, 
video and audio can be played back as well as checking the location while driving 
in coordination with Google Maps. This section describes the procedure to use 
the Dash Camera.

1  Inserting/Ejecting the micro SD card

 ● Inserting the micro SD card

The Dash Camera does not work without insertion of a micro SD card. If the 
micro SD card is not inserted, insert the card while paying attention to the 
following items.

• Confirm that the Dash Camera power is off (LED is off).  
Do not insert a micro SD card while the Dash Camera is running. Otherwise, 
the micro SD card may get damaged.

• When inserting a micro SD card into the Dash Camera, check the direction 
of the card and insert it straight into the slot.

• Insert the micro SD card until you hear a click.

micro SD card

 ● Ejecting the micro SD card

To play back recorded videos on a computer, eject the micro SD card. Gently 
push down the center of the micro SD card and then release it. The micro SD 
card pops out slightly.

• Never eject the micro SD card while the Dash Camera is accessing the card 
(LED is on or blinking). Otherwise it may damage not only the micro SD card 
but also the Dash Camera itself.

• Before ejecting the micro SD card, confirm that the Dash Camera power is 
off (LED is off).

• The Dash Camera does not work without insertion of a micro SD card. Be 
careful not to forget inserting a micro SD card. When the card slot is empty, 
you will hear continuous high-tone beeps.

DASH CAMERA OPERATION
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DASH CAMERA OPERATION

2  Calibration

When the calibration is not set, the buzzer sound of continuous high-tone long 
beep sounds at the time of startup. (See page 14.)

1.  Park vehicle on flat surface. While holding down the ACTION button, turn on 
the ignition.

2.  Keep holding down the ACTION button for three seconds or longer.
 When the calibration is set properly, a double high-tone short beep will sound.
 If the buzzer does not sound, set the calibration again.

3  Starting

The power of the Dash Camera is linked to the ignition key of the vehicle.
While the power of the Dash Camera is off, confirm that the micro SD card is 
inserted.

1.  Turn on the ignition key or the ignition of the vehicle.

The power turns on, and the REC LED (green) of the Dash Camera starts 
blinking and then turns on. (ERROR LED (amber) turns off)
When you hear a short and high-tone beep, startup is finished. However, if the 
buzzer setting is changed, the buzzer does not sound. (See page 39 and 57.)

NOTE
• Just after formatting the micro SD card (See page 47.), the Dash Camera 

creates files that are necessary for recording the videos. Therefore, the time 
until completion of the startup becomes longer.

• Recording a video is not ready until startup is done. The Dash Camera starts 
recording just after startup is finished.

• When an abnormal vibration and/or a shock is detected while the vehicle is 
parked, the power turns on automatically. Then the Dash Camera records 
the video of surrounding area for approximately 60 seconds. (Parking 
surveillance function) (See page 20.) 
When the parking surveillance function is activated, a notification buzzer of 
one long high-tone beep and five short high-tone beep sounds twice at the 
next ignition ON. However, if the parking surveillance function is set off, the 
power does not turn on automatically. (See page 42 and 58.)

Market: Canada
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4  Shutting Down

1.  Turn off the ignition key or the ignition of the vehicle.
 The recording ends and the LED turns off, the power is off.

NOTE
• LED may remain ON depends on camera setting [Surveillance Start Delay]. 

(See page 43 and 58.)

5  Recording Video and Audio

This Dash Camera is a constant-recording type drive recorder. The Dash Camera 
is turned on when the vehicle ignition is turned ON. When startup is done, the 
Dash Camera starts recording video and audio (if microphone switch is turned 
on). The REC LED (green) lights on while recording. When the ignition key or the 
ignition is turned off, recording is stopped. This Dash Camera has special video 
event recording modes to capture and protect important videos.

While driving, recorded videos are automatically protected when the Dash 
Camera detects a strong shock (Event Protection Function – Automatic) or 
the ACTION button on the main body is pressed (Event Protection Function – 
Manual, or Adventure Mode). 

While vehicle is parked and vehicle ignition is OFF, video is recorded when the 
Dash Camera detects an abnormal vibration or shock (Parking Surveillance 
Function).

When the micro SD card is full, older videos are deleted and overwritten by new 
ones in the unit of "Chapter" files (except event-protected video files). Event-
protected video files are explained below:

 ● EVENT PROTECTION FUNCTION - AUTOMATIC (Up to Ten Videos)

When the Dash Camera detects a shock during the normal recording, the Dash 
Camera outputs two short high-tone beeps and protects 20 seconds of recorded 
video: 12 seconds before and 8 seconds after the shock is detected.

 ● EVENT PROTECTION FUNCTION - MANUAL (Up to Five Videos)

Press the ACTION button of the main body during the normal recording.
A short high-tone beep sounds, and the total of 20 seconds of video is protected 
which include the video for 12 seconds before and 8 seconds after the ACTION 
button is pressed.

DASH CAMERA OPERATION
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 ● ADVENTURE MODE (Up to approx. 87 min: Standard mode)

Hold down the ACTION button for more than 1 second during the normal 
recording.
The Dash Camera outputs three short high-tone beeps and protects the recorded 
video for the set maximum recording time of the Adventure mode starting from 
the time when the button is pressed.
While recording in the Adventure mode, holding the ACTION button for more than 
1 second will output three short high-tone beeps and ends the Adventure mode. 
Adventure mode will automatically end if allocated time has been reached and 
will be output beep sounds.

NOTE
• The recording times in the standard recording and the Adventure mode vary 

depending on the selected image quality.
• The maximum recording time in the Adventure mode is about half of the 

maximum recording time in the standard recording.
• When the Adventure Mode is turned off, the protection of recorded video up 

to that point will be cancelled.
• When the memory allocation of the computer or smart phone viewer is 

changed, partial protection of the video recorded up to that point will be 
canceled.  
(For example, if you change the recording time from 87 minutes to 
30 minutes, approximately 30 minutes of your latest video recording will be 
protected, but anything recorded prior to that will be overwritten.)

• The settings can be changed by the viewer software for computer (See page 
38.) or the viewer application for smartphones (Android/iPhone) (See page 57.).

 ● PARKING SURVEILLANCE FUNCTION (Up to Ten Videos)

When an abnormal vibration and/or a shock is detected while the car is parked, 
the video is recorded for 60 seconds from the time of the detection. The recorded 
video is protected.

Normal Wake-Up: 
When the car is parked, if an unusual vibration or shock is detected, it starts 
recording after 4 seconds for about 60 seconds and protects the recorded video.

Quick Wake-Up: 
When the car is parked, if an unusual vibration or shock is detected, it starts 
recording from that point for 60 seconds and protects the recorded video.

NOTE
• The settings can be changed by the viewer software for computer (See page 

38.) or the viewer application for smartphones (Android/iPhone) (See page 57.).
• When the battery voltage reaches the specified value or lower, the Normal 

Wake-Up is automatically activated.

DASH CAMERA OPERATION
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 ● On/off Selection of Audio Recording

Audio recording can be turned on/off by the audio 
recording on/off switch on the Dash Camera.
The REC LED (green) lights on during recording 
regardless of audio recording on/off condition.

 ● Backup Power

The Dash Camera contains internal capacitors for continued recording in cases 
of battery power disconnection. Internal backup power enables recording of 
video for approximately 5 seconds after power loss; however this time is not 
guaranteed. Available time may be shorter in conditions such as low temperatures 
or immediately after camera starts up.

NOTE
• Never take the micro SD card out of the slot while the Dash Camera is 

writing data to the micro SD card (REC LED (green) is on or blinking). 
Otherwise it may damage not only the micro SD card but also the Dash 
Camera itself.

• Quickly and repeatedly turning the Dash Camera on and off generates many 
short videos and the total amount of recording time is decreased.

6  Playing Back Recorded Videos

Play back the video recorded by this Dash Camera with the viewer software for 
Macintosh and Windows computers (See page 22.) or the viewer application for 
smartphones (Android/iPhone) (See page 50.).

7  Checking Device Settings

Check the settings by the viewer software for computer (See page 38.) or the 
viewer application for smartphones (Android/iPhone) (See page 57.).

DASH CAMERA OPERATION

Orange marking

Market: Canada



TOYOTA — DASH CAMERA Page 22

English

Videos and audio recorded by this Dash Camera can be played back on your 
computer. With the viewer software, various settings of this Dash Camera can be 
changed. This section describes the procedure to use the viewer software.

NOTE
• Screenshots are from a computer with Windows 7 Professional Edition (SP1). 

The screen may be different from the actual screens depending on the OS 
and settings.

• The value in "<  >" is the default value.

1  Installing Viewer Software

Download the viewer software from the dedicated web site page.

1.  Start up the web browser such as Internet Explorer and access to the 
dedicated web site page. The URL address is as follows.

 http://www.e-iserv.jp/top/driverecorder/DashCamViewer/index.html?lang=en

NOTE
• Site may be down periodically for maintenance.

2.  Read the License agreement conditions and Disclaimers and select [I Agree].

3.  From the displayed web site page, download the installer for the viewer 
software.

4.  Copy the viewer software installer "DASH_CAM_VIEWER_SETUP_en.exe" to 
a location on your computer (such as the Desktop).

5.  Double-click on "DASH_CAM_VIEWER_SETUP_en.exe".

OPERATIONS OF VIEWER SOFTWARE
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OPERATIONS OF VIEWER SOFTWARE

6.  Click [Next] on the Install Wizard screen. 
Then proceed the installation by following the instructions on the screen.

7.  When installation is finished, a shortcut icon for "DASH CAM VIEWER" is 
created on the Desktop.

NOTE
• To start up the viewer software as soon as the installation is completed, click 

[Finish] while [Launch the program] on the Installation Complete screen is 
checked.

• Depending on your computer, the dialog of "User Account Control" is 
displayed while installing or when starting up the viewer software for the first 
time. Follow the instruction on the screen and always click [Yes].
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2  Playing Back Recorded Videos

Recorded videos can be played back using the viewer software.

Start up the viewer software by the following procedure and play back the video.

1.  Insert the micro SD card ejected from the DASH CAMERA to the computer by 
using the card reader device.

NOTE
• Depending on the computer setting, "What do you want Windows to do?" 

dialog may be displayed when the micro SD card is inserted. In that case, 
click the [Cancel] button, select [Take no action], or close the dialog by using 
the  button at the upper right section.

2.  Double-click on "DASH CAM VIEWER" shortcut icon on the Desktop.

3.  The viewer software starts.

OPERATIONS OF VIEWER SOFTWARE
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4.  Click  button (or select File > Open from the Menu).

NOTE
• To view data on the microSD card, check that the computer has recognized 

the SD card drive.

5.  Click the [Card Data] (video in the micro SD card) button.
  If you play back videos on the computer saved by the backup function (See 

page 35.), click the [Backup Folder] button. If you directly select the video file, 
click the [Select File] button.

• For the folder structure, see page 34.

6.  Select a drive for the micro SD card on the Card Drive Select screen and click 
[OK].

NOTE
Drive letter (Volume label) is reference.

When the Backup Folder Select screen is displayed, select a saved folder and 
click [OK].

OPERATIONS OF VIEWER SOFTWARE
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7.  Select the type of video on the "Trip", "Chapter", "Event", "Surveillance", or 
"Adventure" tab. Then select a video to play back from the list at the right side 
and click .

 The playback starts.

The next video list is displayed on each tab.

Trip List of videos in the unit of each key cycle (from engine on to off)

Adventure List of videos that are protected by the Adventure mode

Chapter List of individual videos within the selected trip / Adventure

Event List of videos protected by the ACTION button and protected by 
detection of shocks

Surveillance List of videos recorded by the parking surveillance function

8.  Click the  button (or File > Exit from the Menu) to end the software.

NOTE
• The number of videos which can be stored in the micro SD card is limited. 

Back up the video data from the micro SD card to your computer if 
necessary. (See page 35.)

OPERATIONS OF VIEWER SOFTWARE
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 ● Configuration of the Viewer screen (example of the "Trip" tab)

(12)

(13)

(11)
(2)

(1)

(3)

(4)

(10)

(9)

(8)

(5)(6)(7)

Video 
during 
playback

(1) End the viewer software.

(2)

Select the video type.

Trip List of videos in the unit of each key cycle (from engine on to off)
Adventure List of videos that are protected by Adventure mode
Chapter List of individual videos within the selected trip / Adventure
Event List of videos protected by the ACTION button and protected by 

detection of shocks
Surveillance List of videos recorded by the parking surveillance function

(3) Displays the recorded date and time (or detected date and time) of the specified 
video type and thumbnails. Depends on Time Zone in viewer setting.

(4)

Displays the location information and date and time of the selected video on the 
map (Google Maps) with an icon. Internet connection is required.

Displays the map in a separate window.
When it is re-clicked, the Map is re-displayed on the Viewer 
screen.
Hides the Map.

Re-displays the Map on the Viewer screen.

Hide/show location balloons

OPERATIONS OF VIEWER SOFTWARE
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(5)
Displays the G value size and direction of the played back video.

Switch between display and hide.

(6)
Displays the speed of the played back video.

Switch between display and hide.

(7)

When the GPS signal is lost (speed and direction are unknown), the GPS icon grays 
out and changes as follows.

Color of the location mark of own vehicle in (4) : Gray
Numeral value of speed in (6) : --
Color of the needle for the speed in (6) : Gray
Color of the speed in the chart in (8) : Gray
* The GPS icon during GPS measurement is yellow.

(8)

The chart that displays the data becomes as follows.
Left vertical axis: Acceleration speed Right vertical axis: Speed 
Horizontal axis: Time Orange: Acceleration
Pink: Speed Vertical line: Video playback position
* Clicking on the chart or dragging can move the playback position.

(9) Operation buttons to play or stop the video (See page 30.).

(10)

Tracking bar that indicates the progress condition of the video playback.
Displays the video playback position by the unit of startup (detection). (See page 30.)
[A]: Position where the Dash Camera detected the acceleration or a shock 
[M]: Location where the ACTION button is pressed

(11) Displays the video only in a full screen.

(12) Icons for viewer operations (See page 29.)

(13) Video file location

NOTE
• There are cases that the GPS signals cannot be acquired correctly; for 

example, right after the Dash Camera is started up, in places where GPS 
receiving condition is poor, such as in a tunnel or high-rise area, and when 
the GPS satellite location is not suitable. In that case, the vehicle location 
and/or the speed is not indicated on the map correctly.

• As the size of G value gets larger, the location becomes further from the 
center. The direction of the G value according to the operation condition is 
as follows.

(During acceleration)

(During deceleration)

(When  
turning right)

(When 
turning left)

• When the progressing direction of the main body is deviated, change the 
sensor sensitivity value. (See page 40.)

OPERATIONS OF VIEWER SOFTWARE
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• If an error message is displayed while loading a video or while playing back 
the video and when the video cannot be played back properly, the image 
data may be damaged. Back up the video data from the micro SD card to 
your computer if necessary (See page 35.) and format the micro SD card.  
(See page 47.)

• Make sure to eject the micro SD card properly during removal.

 ● How to Use Icons (Buttons) for Viewer Operations

Icons (buttons) at the upper section of the viewer enables the following 
operations.

Selects a video from the micro SD card or the computer and play back.

Saves the playback video.

Changes the settings of the Dash Camera.

Cuts the video at a discretional section and saves.

Saves the video as a JPEG image.

Magnifies the selected range of video at a specified magnification ratio.

Displays the stop watch function on a separate window.

Converts the location data of the constant recording into the kmz format 
file that can be displayed on Google Earth and saves the files.

  To magnify a part of video, click  and select a magnification ratio and an area 
(range) to magnify. To cancel magnification, click the magnified image.

 ● Display only the video in full screen

Click  at the upper right section of the video.
To cancel the full-screen mode, click . Cancelling the full-screen mode is 
possible also by clicking the image.

NOTE
• When the micro SD card is full, older videos are deleted and overwritten by 

new ones in the Dash Camera of "Chapter" files (except event-protected 
video files), so if you select the video in the "Trip" tab, it may play back from 
part way through a trip.

OPERATIONS OF VIEWER SOFTWARE
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 ● How to Use Buttons for Playback Operations

The following operations are available with the buttons for playback operations.

(1) (2) (3) (4) (5) (6)

Move the slider to 
adjust the brightness.

Move the slider to adjust the playback speed (×0.5 to ×10).
The current playback speed is displayed at the right side ("Standard" is ×1).

Move the slider to 
adjust the volume.

(1) Plays back from the start position of the former trip.

(2) Plays back from the start position of the next trip.

(3) Plays back the video. It becomes a pause button during playback.

(4) Stops the playback.

(5) Displays the previous frame.

(6) Displays the next frame.

NOTE
• When the screen is dark, adjust the brightness by using the slider at the left 

end of the playback operation buttons. However, some computers may not 
have the brightness control function.

• When /  at the left end of the track bar is clicked, the playback 
starts from the start position of the previous/next chapter (file).

• When the slider on the track bar is moved, the playback starts from 
the position specified by the slider.

When there are three recorded files
First file Second file Third file

When the slider is moved 
within this range, the playback 
starts from the specified 
position in the first file.

When the slider is moved 
within this range, the 
playback starts from the 
specified position in the 
third file.

OPERATIONS OF VIEWER SOFTWARE
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 ● How To Use Stopwatch Function

The stop watch function is available in a separate window. Click  at the 
upper section of the screen.
During the measurement, the lap time (elapsed time in the section) can be 
checked by specifying the discretional area.
Up to ten split times can be specified per lap time, including the start (S)/end (E) 
position and nine additional points.

Total time

Starts/stops the 
measurement  
by the stopwatch.

Clears the last lap time 
information measured.

The lap time is displayed in a list 
on the list screen.

Average

• Specifies the measurement point (1 to 9) 
of the lap time. (Max. of 10 sections 
including the starting/stopping point)

• Clears all measurement results after the 
measurement stops.

NOTE
• During the measurement, the start position/measuring points/end position is 

displayed on the track bar.
 S:  Start position
 1 to 9:  Measuring points
 E:  End position

• During the measurement, the position does not return to the position before 
the start position or before the last lap point, even when the Previous 
Chapter button or the slider on the track bar is operated.

• The lap point can be specified during the frame advance or frame return 
operations.

• The lap time indicates the sectional time from the previous lap to the current 
lap.

• When the playback is ended/stopped, the measurement stops, and the final 
lap time is displayed.

• During the stop watch operation, when the track bar is operated over the 
files, loading may take a long time.

• There is a chance that the difference (max. 0.9 sec.) occurs between the 
sum of lap times and the total time.

OPERATIONS OF VIEWER SOFTWARE
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• Stop Watch data cannot be saved. In order to save the data, please take a 
screenshot using the Print Screen key or other software.

• During the measurement, click  and select the video type. The 
confirmation screen for deletion of measurement result is displayed. Click 
[OK] when specifying a different video. When the Video Type Select screen 
is closed by clicking [Cancel], the screen returns to the Measurement 
screen.

 ● Clears the measurement result.

Click the  button after the measurement stop.

 ● How to Trim Video Section

When the  button is clicked in the image at the starting point (position) for 
trimming, the Trim Range Determination screen is displayed as shown in the 
following section. Move the slider on the track bar to select the end position of 
trimming. A maximum of 30 minutes can be trimmed.

Moving the track bar emphasizes the 
trim range in red.

Re-click the  button at the end point (position) for trimming on the image.
On the next "Trim Tool" screen, select information to be embedded in the video 
with a check mark and click [Save]. The cut video can be saved when the 
destination for saving is specified.
However, if information is embedded, trimming the video will take a long time.

NOTE
• If you trim a video that has already been trimmed, additional information 

cannot be added.

OPERATIONS OF VIEWER SOFTWARE
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 ● How to Capture the Video Screen

To save the displayed image in a JPEG file, click the  button. On the screen 
to select information to be embedded in the screen, check the items to be 
displayed on the image and click [OK]. Then specify the destination folder for the 
file and save the file in your computer.

 ● Converting Location Data for Google Earth

Select a video to be converted and click the  button.

NOTE
• Before converting, install Google Earth to your computer. 

Google Earth can be downloaded from the Google site.

Specify the storage destination and the file name and click [Save]. On the Startup 
screen of Google Earth, click [Yes]. Google Earth starts.

Expand the saved file displayed at the left side of the Google Earth screen by 
clicking [+]. Select [Route].

When the  (Tour playback) button is clicked, the travelling route is displayed.

After clicking [Route] > [+], select [My car]. Then clicking the  (Tour playback) 
button plays back the travelling route in a 3D video.
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 ● Folder Structure and File Name

In the micro SD card, the folders and recorded data are saved as follows.

MOVE

MOVE01
YYMMDDhhmmss_nnnn.MP4 

DRINF

YYMMDDhhmmss_nnnn.MP4 
MOVE02

YYMMDDhhmmss_nnnn.MP4 
MOVE03

YYMMDDhhmmss_nnnn.MP4 
MOVE99

microSD memory card

Folder for constant recording (MP4)

Folder for operation recording
(including data file/log file)

Folder for recording

Video file

Within one folder
Max. 50 files

Max. 99 folders

• The video file names are allocated in the following rules.
 YYMMDD hhmmss _ nnnn . MP4
   Serial number 
  Hour, Minute, Second (Time when recording was started) 
 Year, Month, Date

• The Dash Camera automatically assigns time stamps to recorded video files 
using UTC (Coordinated Universal Time).

• If you connect to Wi-Fi and interrupt the recording, and then disconnect from 
Wi-Fi and start recording, the date and time of the file name is changed from 
that point.

NOTE
• Do not change the video file name. There is a possibility that playback using 

the viewer software becomes unavailable. In addition, do not delete folders 
and files (SETINF.DAT, GROUP.DAT, etc. in the directory).

• After camera's initial power on, "DUMMYMOVExxxx.DAT" files are created 
in the MOVE folder of the microSD card. This file is necessary to record the 
images. Do not delete the file. Once the videos are recorded, the files are 
saved as video files.

• When the "DUMMYMOVExxxx.DAT" file or the video file is accidentally 
deleted, the "DUMMYMOVExxxx.DAT" file is created again at the time of 
startup of the Dash Camera. Therefore, the time before startup of recording 
becomes longer.
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3  Backing Up Data in Micro SD Card to Computer

The number of files that the micro SD card can store is limited due to its capacity. 
When the micro SD card is full, the oldest files are overwritten by newer files. 
In this case, the older overwritten files will not be available for viewing. It is 
recommended to back up the video data from the micro SD card to your computer 
before older files are overwritten in order to prevent potential data loss.

With the viewer software, the recorded data in the micro SD card can easily be 
saved (backed up) to your computer with simple operations from the Menu.

 ● Select the folder for backup.

1.  On the viewer software, read the recorded data in the micro SD card and 
select Settings > Backup Directory Settings from the Menu.

2.  Select a folder to save the backup data and click the [OK] button.

NOTE
• If the destination folder is not specified, the backup data will be saved in the 

"My Videos" folder.
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 ● Backing Up Data to Computer

1.  On the viewer software, read the recorded data in the micro SD card and 
select Back up > Back Up on the Menu.

2.  On the Backup Data Select screen, check the data to be saved and click the 
[OK] button.

• Selected recorded data are backed up (saved) in the specified destination.
• The folder's default name is the date and time of backup operation.
• To playback backup videos, refer to "2 Playing Back Recorded Videos" (See 

page 24.).
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4  Deleting Backup Data on Computer

Recorded data backed up with "3  Backing Up Data in Micro SD Card to 
Computer" (See page 35.) can be easily deleted by the simple operation from the 
Menu.

1.  Startup the viewer software and select Back Up > Delete from the Menu.

2.  Select a folder for deletion and click the [OK] button.

NOTE
The folder name is reference.

3.  Select data to be delete and click the [OK] button.

NOTE
The folder name is reference.

Selected backup files will be deleted.
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5  Changing Camera Settings

When the Dash Camera settings are changed and saved to the micro SD card 
with the viewer software, the updated settings can automatically take effect on 
the Dash Camera after the micro SD card is properly inserted and the ignition key 
is turned on.

1.  Insert the ejected micro SD card to your computer by using the card reader 
device.

2.  Start up the viewer software and select Settings > Camera Settings from the 
Menu.

3. Select the drive for the micro SD card and click [OK].

  The Setting screen of the main body is displayed.

NOTE
Drive letter (Volume label) is reference.

NOTE
• When there is no operation record in the micro SD card (or when the micro 

SD card is used for the first time), "The configuration file cannot be read." 
message is displayed. Click the [OK] button.

• If the previous setting is saved in the micro SD card, the former setting is 
displayed.

4.  Set each item and click the [OK] button.

5.  Click the [OK] button on the Setting Save Confirmation screen.
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Save the new settings on the micro SD card. When the micro SD card is inserted 
to the Dash Camera and the ignition key is turned on, the new settings saved on 
the micro SD card will take effect on the Dash Camera. The changeable setting 
items are as follows.

 ● Basic Settings

Recording quality
Maximum recording time will be reduced with increased video quality.
Three steps of High quality mode / <Standard mode> / Extended time mode.

Sound
Sets the Notification Volume, System Volume, Error Warning Volume - SD 
Card Error and Surveillance Mode Notification .
Three steps of <High> / Low / Off.

Wi-Fi Password
Resets the password for the Dash Camera.

Reset All
Resets the entire settings of the Dash Camera to default setting.

OPERATIONS OF VIEWER SOFTWARE

Market: Canada



TOYOTA — DASH CAMERA Page 40

English

 ● Sensor Sensitivity Settings

Acceleration/Deceleration Sensitivity
Select the sensor sensitivity to detect the shock from <Standard> / High 
Sensitivity. Or set the sensitivity (setting: 0.30G to 0.70G) manually by using 
the slide bar. When the sensitivity is set high, shocks are more easily detected.

Left/Right Sensitivity Adjustment
Adjust the sensitivity adjustment value for the left/right (horizontal) direction. 
If too many false events are detected when turning left/right, increase the 
adjustment value. However increasing to higher value may prevent the Dash 
Camera from detecting actual events.

Center Offset Angle
By using the sliding bar, set the correction angle (setting range: -45 to +45 deg.) 
in the progressing direction.
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• When the sensor sensitivity is set high, shocks are more easily detected.
• The horizontal axis correction does not affect the front/rear direction (vertical 

axis).
• To calibrate the correction angle, check for deviation by playing back the 

video. If the angle is deviating to the left, correct with the negative direction. 
If the angle is deviating to the right, correct with the positive direction.

NOTE
• After changing the setting, compare with the actual driving and check that 

the Dash Camera detects shocks properly (not too much or too less). 
When checking the Dash Camera sensitivity, never try dangerous 
operations (such as sudden acceleration and sudden braking).

• Do not change the sensor sensitivity without thorough consideration.
• When sensor sensitivity is set too low, the frequency of false event data 

decreases.  However, necessary event data may not be protected.
• When the Dash Camera detects the shock unnecessary in left and right 

turns or curves (unnecessarily protected more often), adjust the set value of 
the horizontal axis correction.
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 ● Parking Surveillance Settings

Parking Surveillance
Enables/disables Parking Surveillance mode.

Sensor Sensitivity
Select the sensor sensitivity to detect the shock from <Standard> / High 
Sensitivity. Or set the sensitivity (setting: 0.20G to 0.80G) manually by using 
the slide bar. When the sensitivity is set high, shocks are more easily detected.

Parking Surveillance Mode
Select Mode

When "ON" is selected for the parking surveillance function,  
select <Normal Wake-Up> / Quick Wake-Up.

Normal Wake-Up: When the car is parked, if an unusual vibration or shock 
is detected, it starts recording within 4 seconds for about 60 seconds and 
protects the recorded video.

Quick Wake-Up: When the car is parked, if an unusual vibration or shock is 
detected, it starts recording within 1 second from that point for 60 seconds and 
protects the recorded video.
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Duration for Quick Wake-Up mode
When [Quick Wake-Up] is selected, the monitoring time can be set between 
30 min to 180 min.

Once the monitoring time elapses, or if the vehicle’s battery drops below the 
specified value, it switches automatically to Normal Wake-Up mode at that 
point, to avoid a dead battery.

NOTE
• Do not carelessly change the sensor sensitivity.
• When sensor sensitivity is set too low, the frequency of false event data 

decreases.  However, necessary event data may not be protected.

Surveillance Start Delay
To prevent erroneous detection of shock by the door opening/closing when 
getting in and out of the vehicle, the time lag to start the parking monitoring 
function is set after turning off the Ignition.
Surveillance Start Delay will also prevent notification if shock is detected within 
the 1 or 2 minute interval before ignition is turned ON.
・Normal Wake-Up: <1 min> / 2 min
・Quick Wake-Up: <1 min> / 2 min

NOTE
• Purpose of this setting is to prevent false notification of parking incident 

when exiting/entering vehicle.
• Camera will remain ON for duration of selected Surveillance Start Delay 

after Ignition is turned OFF.
• If shock is detected within selected setting time of ignition ON, video will be 

recorded but buzzer will not turn on.
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 ● Adventure Mode Settings

Adventure Mode
Enables/disables Adventure mode.

NOTE
• When the Adventure Mode is turned off, the protection of recorded video up 

to that point will be cancelled.

Memory Allocation
Sets the recording time when the Adventure mode is on.
Recording time is based on allocated memory and video quality setting. 
Longer recordings can be achieved by increasing the memory, or reducing the 
video quality. Increasing memory allocation for Adventure mode will reduce 
available memory for normal continuous recording mode.
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6  Changing Viewer Setting

The viewer software settings can be changed. The following items can be set.

1.  Start up the viewer software and select Settings > Viewer Settings from the 
menu.

Language
Selects the language from <English> / French / Spanish.

Date & Time
There are 4 date & time setting as follows:

 ● MM/DD/YYYY HH:MM:SS (AM/PM)  ● YYYY/MM/DD HH:MM:SS (AM/PM)
 ● <MM/DD/YYYY HH:MM:SS (24H)>  ● YYYY/MM/DD HH:MM:SS (24H)

Time Zone
There are 8 time zone setting as follows:

 ● PST-Pacific (UTC-8)  ● CST-Central (UTC-6)
 ● NST-Newfoundland (UTC-3:30)  ● MST-Mountain (UTC-7)
 ● AST-Atlantic (UTC-4)  ● AKST-Alaska (UTC-9)
 ● <EST-Eastern> (UTC-5)  ● HAST-Hawaii (UTC-10)

Daylight savings time
Sets ON / <OFF> of the daylight savings time. When the daylight savings time 
is ON, the time is one hour ahead from the standard time.
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Units
Sets the display unit of the speed meter from <KM/H> / MPH.

2. Set each item.

3. Click the [OK] button.

4. Click the [Yes] button to re-start viewer.
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7  Formatting Micro SD Card

If an error is displayed when the video is played back or the video data is copied, 
the data in the micro SD card may be corrupt. Format the micro SD card in the 
following procedure.

NOTE
• After formatting, the video data in the micro SD card are deleted.
• Formatting the micro SD card may not often be necessary. Format the micro 

SD card only when a write/read error occurs in the micro SD card or when 
the Dash Camera does not start up.

• Back up the desired video data to your computer prior to formatting the 
micro SD card. (See page 35.)

1.  Prepare the software used for formatting the SD memory card.

Install the software used for formatting the SD memory card in your computer. 
See the dedicated web site page for the installation procedure.

(1)  Start up the web browser such as Internet Explorer and access the 
dedicated web site page. The URL is as follows.

http://www.e-iserv.jp/top/driverecorder/DashCamViewer/index.html?lang=en

(2)  Select "Download software to format SD memory cards."

(3)  Install the "Download software to format SD memory cards" by following 
the described procedure.

2.  Start up the software used for formatting the SD memory card.

Select Start > All programs > SDFormatter > SDFormatter.
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3.  Click the [Format] button.

NOTE
• Be sure to confirm that the drive letter at "Drive:" indicates the drive of which 

the micro SD card is inserted. Then start formatting the micro SD card.  
If the selected drive is incorrect, select the drive that the micro SD card is 
inserted by clicking the [Redo] button.

4.  When formatting completes, the confirmation dialog is displayed. Click the [OK] 
button.

5.  Click the [Exit] button to close the dialog.

NOTE
• After formatting the microSD card, insert it into the Dash Camera SD slot, 

and turn on the power to complete the activation process. (REC LED (green): 
Blinking to On) (See page 18.)  
If the activation process is not completed, it may take approximately 1 minute 
for video to start recording on next startup, or may not record in parking 
surveillance mode.
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8  Downloading PC Viewer Software Updates

The "Download Updates" function can be accessed by clicking "Help(H)" located 
at the top menu bar. The installer and instruction manual of the latest viewer 
software can be downloaded.

1.  Select Help > Download Updates from the menu.

The download site of the installer and instruction manual of the latest viewer 
software is displayed. Connection to the Internet is required for downloading.

9  Displaying Version Information

The version information of the viewer software can be displayed by the following 
procedure.

1. Select Help > Version Information from the Menu.

The version information of the viewer software is displayed.

NOTE
The version information is reference.
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When the Dash Camera is connected to the smartphone (Android/iPhone) by Wi-
Fi connection, the videos and audio recorded by the Dash Camera can be played 
back on the smartphone.

A special viewer application is used for the playback. In addition, various settings 
of this Dash Camera can be changed with the viewer application.

NOTE
• The Wi-Fi function cannot be used while driving. Park the vehicle at a safe 

place first before operating the application functions.
• Images shown here are of Android Smartphones. Procedures are the same 

in iPhones.
• No video recording while Wi-Fi connection to the smartphone (Android/

iPhone) is on.
• Wi-Fi is disconnected if camera detects vehicle movement.
• Start the viewer application with the language set to the smartphone.

However, if a language other than English, French, or Spanish is set, the 
viewer application starts up in English.

• Firstly, please confirm if your smartphone Wi-Fi setting has been turned on.
• If the Dash Camera is not connected to Wi-Fi, a popup occurs to confirm 

connection. (If the Dash Camera is connected to Wi-Fi, this popup does not 
occur).

• During Wi-Fi connection, the Dash Camera stops video recording. When 
recording the video, close the viewer application.

• The viewer app for smartphones can only be used if the Dash Camera is 
connected to Wi-Fi.

• For the Wi-Fi connection procedure, see the instruction manual of your 
smartphone.

• The value in "<  >" is the default value.

1  Installing Viewer Application

1.  Search the "TOYOTA DASH CAMERA" and download the application from 
your smartphone app store.

• For Android smartphone: Google Play Store
• For iPhone: App Store

OPERATIONS OF VIEWER APPLICATION FOR 
SMARTPHONES
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2  Connect a smartphone with the Dash Camera in Wi-Fi connection

 For Android smartphone

1. Start the viewer application.

  When the License Agreement screen is displayed, please read this Agreement 
before using the application, and  select [I Agree].

NOTE
• You must agree with the License Agreement in order to use the application.

2.  When the application is started, select [NEXT] three times and then 
select [Got It].

3.  Select [OK] when the Wi-Fi connection confirmation screen appears.

4.  Go to Home screen > Settings > Wi-Fi > Wi-Fi Direct.

NOTE
• This procedure may vary based on smart phone. Consult smart phone 

owner's guide for connecting Wi-Fi direct.

5.  Wait a few seconds on the Wi-Fi Direct screen.

6.  Available peer-to-peer device name (DR_0000_XXX00000_DR) appears on 
the screen, and select the device name.

NOTE
• The device name "XXX" and "00000" are depends on model.
• When the peer-to-peer status changes from "Available" to "Connected", the 

pairing is completed.
• Camera Wi-Fi device name may not appear until 1 minute after camera has 

been turned ON (ignition ON).

7.  Go back to the DASH CAMERA application screen.

8.  Enter the Wi-Fi password.

NOTE
• The default Wi-Fi password: Serial number for this Dash Camera.  

(See back cover and page 13.)
• The password for Wi-Fi connection can be changed. (See page 61.)

9.  Go to next title "3 Playing Back Recorded Videos". (See page 53.)

NOTE
• No video is recorded while Wi-Fi connection is active.
• Wi-Fi is disconnected if the Dash Camera detects vehicle movement.
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 For iPhone

1. Go to Home screen > Settings > Wi-Fi.

2.  Select the device name (DIRECT-DR_0000_XXX00000) from the list of 
CHOOSE A NETWORK... screen.

NOTE
• The device name "XXX" and "00000" are depends on model.

3.  Enter the Wi-Fi password, and select the Join. The Wi-Fi pairing process is 
complete.

NOTE
• The default Wi-Fi password: Serial number for this Dash Camera.  

(See back cover and page 13.)
• The password for Wi-Fi connection can be changed. (See page 61.)

4. Start the viewer application.

  When the License Agreement screen is displayed, please read this Agreement 
before using the application, and select [I Agree].

NOTE
• You must agree with the License Agreement in order to use the application.

5.  When the application is started, select [NEXT] three times and then select 
[GOT IT].

6.  Go to next title "3 Playing Back Recorded Videos". (See page 53.)

NOTE
• No video is recorded while Wi-Fi connection is active.
• Wi-Fi is disconnected if the Dash Camera detects vehicle movement.
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3  Playing Back Recorded Videos

1. Select "Trips", "Events", and "Adventures" to select the video type.

Trips

Events

Adventures
[All]

[Incident]
[Parked]

[Flagged]
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2.  Select a desired video from the video list.

• When the title is selected on the "Trips" tab, the list of files in the chapter is 
displayed.

• The thumbnail, date and time, event type (G detection, video during parking, 
ACTION button operation, and Adventure recording) is displayed.

• The specified video is loaded in the viewer application and played back by 
each file.

• When the video data is selected from the list of video data, the file is 
downloaded from the Dash Camera and displayed. Videos are played back 
by each file (constant recording: 36 MB, event recording: 12 seconds before 
and 8 seconds after the event).

• The downloaded video data are saved in the smartphone.
• The recorded video, time of video, map indicating the location information, 

speed, and G value are displayed on the screen.
• When the full-screen display button is selected, or when the smartphone is 

turned sideways, the screen shifts to the full-screen state.
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 ● Configuration of the viewer screen (video file selection)

(1)

(2)

(3)

(4)

(5)
(9)

(8)(7)(6)

(1) Displays the setting menu.
 Dash Camera configuration (See page 57.)
 Viewing Camera Image (See page 60.)

(2) Trip folder
(3) Displays or hides the video files in Trip folder.
(4) Video file / Select a video file to download and playback
(5) Displays the thumbnail of the video files.
(6) Displays Trip
(7) Displays Event

If there are any videos that have not been checked, the number of videos is 
displayed at the top right of the icon.

(8) Displays Adventure
If there are any videos that have not been checked, the number of videos is 
displayed at the top right of the icon.

(9) Event icon
: Manual recording file(s)
: Incident recording file(s)
: Parking Surveillance recording file(s)
: Adventure recording file(s)

OPERATIONS OF VIEWER APPLICATION FOR 
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 ● Configuration of the viewer screen (video is during playback)
(1)

(2)

(3)

(4)

(5)

(6)

(9)

(7)(8)

(1) Uploads and shares recorded video to the social media site. (See page 59.)

(2) Displays the setting menu.
 Dash Camera configuration (See page 57.)
 Viewing Camera Image (See page 60.)

(3) Displays the map and the location information.

(4) Displays the video recorded time, speed, and G value.

(5) Recorded video

(6) Goes into the full-screen display when selected.

(7) Displays the next recorded video.

(8) Displays the previous recorded video.

(9) Displays the recorded video select screen.
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4  Changing Camera Settings

The settings of this Dash Camera can be changed. The changed contents are 
sent to the Dash Camera when [SAVE] is selected. The new settings will take 
effect when the Dash Camera is restarted.

1. Select the Sidebar menu ( ) and then select [Settings].

2. Select the item of which setting is to be changed.

Item Function

Video Quality Low / <Standard> / High

Unit <KM/H> / MPH

Set Automatically ON / <OFF>

Set Time Zone AST-Atlantic / <EST-Eastern> /
CST-Central / MST-Mountain /
PST-Pacific / AKST-Alaska /
HAST-Hawaii / NST-Newfoundland

Sounds

     Notification Volume Off / Low / <High>

     System Volume Off / Low / <High>

     Error Warning Volume - SD Card Error Off / Low / <High>

     Surveillance Mode Notification Off / Low / <High>
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Item Function

Sensitivity

     Sensor Sensitivity Restore the sensitivity settings to the 
factory default values.

     Acceleration/Deceleration Sensitivity Low to High (0.1 G Unit) <0.5>

     Right/Left Sensitivity Low to High <1>

     Centre Offset Angle –45 to 45 (1 degree Unit) <0>

Adventure mode

     Adventure Mode <ON> / OFF

     Memory Allocation High quality: Approx. 1 min to 65 min
Standard quality: Approx. 1 min to 85 min
Low quality: Approx. 1 min to 130 min

Parking Surveillance

     Parking Surveillance <ON> / OFF
When the Adventure Mode is turned off, 
the protection of recorded video up to that 
point will be cancelled.

     Parking Surveillance Mode <Normal Wake-Up> / Quick Wake-Up

     Duration for Quick Wake-UP mode When Quick Wake-UP is selected, the 
monitoring time can be set between 30 min 
to 180 min. <30 min>

     Parking Surveillance Restore the sensitivity settings to the 
factory default values.

     Parking Surveillance Sensitivity 0.20 G to 0.80 G  <0.30 G>

     Surveillance Start Delay Normal Wake-up: <1 min> / 2 min 
Quick Wake-up: <1 min> / 2 min

Password Wi-Fi password change
8 to 19 characters (include letters, numbers 
and symbols) (See page 61.)

Reset Reset to Factory settings
(Wi-Fi password is not reset)

3. Select [SAVE].
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5  Uploading or Sharing Recorded Video/Photo to Social Media Site

The video can be uploaded or shared to the social media site.

1.  Select the share button ( ) during playback of the recorded image to select 
desired output (video, image or map).

2.  Select an application from the list of applications. Next, upload or share the 
information by operating the application started up.

The following applications are available to use.

Target apps
Shared data

Video Photo Map
Mail ○ ○ ○
Message *1 ○ ○ ○
Facebook ○ ○ ○
Twitter × ○ ○
YouTube ○ × ×

*1: iOS only
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6  Viewing Camera Image

The real-time camera image can be viewed on the smartphone.

1.  Select the Sidebar menu ( ) and then select [Live Video].

Show Guides Close Camera/Last ViewClose Camera/Last View Hide Guides

NOTE
• Video is not recorded with this function.

OPERATIONS OF VIEWER APPLICATION FOR 
SMARTPHONES

Market: Canada



TOYOTA — DASH CAMERA Page 61

OPERATIONS OF VIEWER APPLICATION FOR 
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7  Changing Password for Wi-Fi

The password necessary for Wi-Fi connection to the Dash Camera can be 
changed.

1. Select the Sidebar menu ( ).

2. Select [Settings], change the password and then select [Done].

3.  Once you select [Done] on the Settings screen, the new settings will take 
effect on the Dash Camera.

NOTE
• If Wi-Fi password is forgotten, the password can be reset to factory default 

using the Windows/Macintosh viewer. (See page 39.)
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Question Answer

When the power of the vehicle 
is turned on, the LED does not 
turn on/the power does not turn 
on.

There may be an issue with the power supplied 
to the Dash Camera.
Consult the dealership where you purchased the 
Dash Camera.

How can I check the video 
recorded successfully?

Check that the video is displayed using the 
Viewer software (See page 22.) or the smartphone.  
(See page 50.)

Can I intentionally delete the 
data in the micro SD card?

The video data can also be deleted by formatting 
of the micro SD card.

The dedicated micro SD card is 
inoperative. What can I do?

Format the micro SD card. (See page 47.)
If recording is still unavailable, consult the 
dealership where you purchased the Dash 
Camera.

Buzzer sound is too low. Can I 
raise the volume?

The volume of the buzzer can be changed on the 
viewer software. (See page 39 and 57.)

Is recording available when the 
battery is disconnected due to 
a shock during an accident?

The Dash Camera contains a backup battery 
for unexpected battery disconnection during an 
accident. The backup battery enables recording 
the video for approximately 5 seconds* after the 
power shutdown; however this recording is not 
guaranteed.
* The backup battery is rechargeable, so back 
up may not be possible right after the power is 
turned on or in the low temperature.

Can I change the recording 
time?

See page 67 for the recording time.
Change the image quality mode by the viewer 
software. (See page 39 and 57.)
* Performance cannot be guaranteed when a 
commercially available micro SD card is used.

I cannot find a recorded video. This Dash Camera is a constant-recording type 
of video recorder. When the micro SD card is 
full, older videos are overwritten in the unit of 
"Chapter" files (except event-protected video 
files). Please download any important videos 
to your computer or smartphone as soon as 
possible.

TROUBLESHOOTING INFORMATION
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Question Answer

The Dash Camera cannot 
recognize the traffic signal 
color.

If only the traffic signal light is not displayed, it is 
not necessarily a failure with the Dash Camera.
Depending on the video recording frequency 
and the LED type traffic signal frequency, there 
is a possibility that the traffic signal appears 
to be off. In addition, there is a possibility that 
the traffic signal color is not visible under some 
circumstances such as the backlight. In that 
case, judge the traffic signal color from the 
contents of video before and after the timing and 
from the vehicle conditions around the vehicle. 
We are not liable for the condition that the traffic 
signal color cannot be detected.

The power of the Dash Camera 
cannot be turned off even when 
the engine is turned off.

Camera power off delays depends on camera 
setting. (See page 42 and 58.)
Consult the dealership where you purchased the 
Dash Camera.

The Dash Camera does not 
start.

Consult the dealership where you purchased the 
Dash Camera.

The video cannot be recorded 
onto the micro SD card.

The Dash Camera may not be working properly 
due to the following reasons. Please check.
Is the micro SD card in a normal condition? If 
there is any problem, format the micro SD card.  
(See page 47.)
Is the micro SD card genuine or the one provided 
with the Dash Camera? Micro SD card provided 
with the Dash Camera is industrial grade with 
longer life compared to other commercially 
available micro SD cards. Performance cannot 
be guaranteed when a commercially available 
micro SD card is used.

The start-up time before the 
recording starts is long.

When the micro SD card has space at the time 
of formatting, the "DUMMYMOVExxxx.DAT" file 
is created. Therefore, the time before startup of 
recording becomes longer.

The recording time is shorter 
than 150 minutes.

Please check if there is other files in the micro 
SD card or Adventure mode video files. Or, when 
short drives are repeated, the number of on/off 
counts of the Dash Camera increases. In that 
case, the recording time gets shorter.

TROUBLESHOOTING INFORMATION
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Question Answer

Event file frequently created.  
Why?

The sensor sensitivity can be adjusted by the 
viewer software. (See page 40 and 58.) Please 
perform "calibration".  (See page 18.)
If it cannot be solved, consult the dealership 
where you purchased the Dash Camera.

When getting in or out of the 
vehicle, parking surveillance 
protected files are automatically 
created.

Check the parking surveillance function 
sensitivity settings and adjust if necessary.  
(See page 42 and 58.)

Files recorded during parking 
contain many files without any 
abnormal conditions. The video 
file is not created even after the 
vehicle is hit while in a parked 
condition.

Check the parking surveillance function 
sensitivity settings and adjust if necessary.  
(See page 42 and 58.)

• The Dash Camera has 
come off the windshield and 
I would like to reinstall it by 
myself. 

• I would like to relocate the 
Dash Camera on the other 
part of the windshield. 

Double sided tape can be purchased at your 
dealership. Do not use other double sided tape. 
Please consult your dealership for details.
(Please take note of the following when replacing 
double sided tape.)
• Remove all remaining adhesive from the Dash 

Camera. Clean the contact surface of the 
Dash Camera and the windshield. They must 
be free of dust, oil, etc. before you reinstall it 
on the windshield.

• Avoid the installation of this Dash Camera in 
low temperatures. Make sure the windshield 
temperature is at 20ºC (68ºF) or higher before 
reinstalling the Dash Camera.

• Refer to the Dash Camera installation manual 
when you install the Dash Camera on the 
windshield.  

• Please perform "calibration". (See page 18.)

Wi-Fi network does not appear. Wi-Fi network may take 1 minute to appear after 
ignition is turned ON.

TROUBLESHOOTING INFORMATION
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Question Answer

I do not have a computer. Can I 
see the recorded video?

Recorded videos can be played back by the 
viewer application for the smartphone.  
(See page 50.)

The OS of computer is 
Windows 98, ME, 2000, XP, or 
Vista. Can I see the videos?

The viewer software does not start up with the 
OS older than Windows 7.

The viewer software does not 
start.

The viewer software does not support older 
operation system.
Confirm the required specifications of Windows 
computers or Macintosh computers from the 
following URL.

http://www.e-iserv.jp/top/driverecorder/
DashCamViewer/index.html?lang=en

In case if the OS is a proper version but the 
software does not start, the file of the viewer 
software may be corrupted. Re-install the 
software. (See page 22 and 49.)
The viewer software does not support other OS 
such as Linux.

Can I watch the recorded 
videos with the general-
purpose software such as 
Windows Media Player, etc.?

Yes. However, distinguishing between the 
constantly-recorded videos and other videos that 
were protected by using the ACTION button is 
not possible. In addition, not all general-purpose 
software can be used for playback.

The video does not start 
playing back even the playback 
button is pressed.

Open the file again and playback. If the playback 
still does not start, the video file may be 
corrupted. When the file is corrupted, playback 
is not possible. Delete the file that cannot be 
played back. If the file cannot be deleted, backup 
the necessary files in the micro SD card.  
 (See page 35.)  
Then, format the micro SD card. (See page 47.)

The video image is disturbed 
and/or the voice is interrupted 
during playback.

End the viewer software and re-start up the 
viewer software to play back the video.

Viewer software was 
accidentally deleted.

Software can be downloaded from the download 
site. (See page 22, 49 and 50.)

The computer does not 
recognize the micro SD card 
when the card is inserted.

The micro SD card may not be properly inserted 
in the computer. Eject the micro SD card once 
and insert it again. In addition, when the card 
reader is used, the card reader itself may not be 
recognized by the computer.

TROUBLESHOOTING INFORMATION
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Question Answer

When the setting screen of 
the Dash Camera is opened, 
a warning message, "The 
configuration file cannot be 
read." opens.

When opening the setting screen of the 
Dash Camera, the Dash Camera loads the 
configuration record file that was actually 
working from the micro SD card.
This actual configuration record file does not 
exist right after purchasing or after formatting 
the micro SD card. In that case, the warning 
message on the left is displayed; this is normal.
Select the [OK] button.

When I select a video in the 
"Trip" tab, it plays back from 
part way through a trip; is it 
supposed to do this?

When the micro SD card is full, older videos 
are overwritten in the unit of "Chapter" files. If 
old files that would be overwritten are event-
protected, the protected files are left as is, so 
when you select a video in the "Trip" tab, it may 
start playing partway through a trip.

I changed the setting on the 
setting screen of the Dash 
Camera and loaded. However, 
the changed setting is not 
reflected.

Insert the micro SD card into the Dash Camera 
and start up. The set content becomes reflected.

The location of the vehicle on 
the map is deviated from the 
actual location.

Depending on the location such as a high-rise 
area or the GPS satellite condition, the GPS data 
cannot be properly received, and the location 
of the vehicle may be displayed at a deviated 
location on the map.

The speed of the vehicle is 
deviated from the actual speed.

The speed is acquired from the GPS data. 
Depending on the location such as a high-rise 
area or the GPS satellite condition, the speed 
may be different from the actual speed.

The playback speed slows 
down sometimes.

When the size of recording data increases, the 
frame rates is lowered in order to secure the 
recording time. In this case, the video seems 
slow sometimes.

When the playback button is 
pressed, the image is played 
back but without voices.

Confirm microphone switch position.  
Confirm the volume setting of the viewer 
software. Check the settings. (See page 30.)
Confirm that the volume setting of computer or 
smartphone is not at minimum.

TROUBLESHOOTING INFORMATION

Viewer Software (continued)

Market: Canada
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Item Specification

Operating temperature range -20 to +65°C / -4°F to 149°F

Storage temperature range -30 to +85°C / -22°F to 185°F

Power supply voltage 12 VDC

Consumption current 1A or lower

External dimension 85 mm(H) × 55 mm(W) × 36 mm(L) 
3.3 in(H) × 2.1 in(W) × 1.4 in(L) 
(excluding projecting parts)

Weight 146g (5.15 oz)

Recording method Continuous Recording

Movie recording time *1

(when an 8-GB microSD 
card is used)

High:  Approx. 130 min
Standard:  Approx. 170 min
Long Time Mode:  Approx. 260 min

Number of video frames 28 frames/sec

Image size (Bit rate) High:  1920 × 1080 (Approx. 8 Mbps)
Standard:  1920 × 1080 (Approx. 6.2 Mbps)
Long Time Mode: 640 × 360 (Approx. 4 Mbps) 

Number of protected records Manual Event Protection:  5 records
Automatic Event Protection:  10 records
Parking Surveillance:  10 records

Clock accuracy Correct by GPS

Photographic element 1/2.7" Color CMOS

Number of effective pixels Approx. 2-million pixels

Angle of field Horizontal 117° × Vertical 70°

Video/voice compression 
method

MP4 (H.264 + AAC)

Wireless LAN IEEE 802.11 b/g/n
 Frequency band: 2.4 to 2.4835 GHz
 Type of modulation: DSSS: BPSK/QPSK/CCK
  OFDM: BPSK/QPSK/16QAM/64QAM
 Transmission rate: 802.11b: 11 Mbps (max)
  802.11g: 54 Mbps (max)
  802.11n (20 MHz): 72.2 Mbps (max)  

Certificate FCC ID: BABFT0112A
IC: 2024B-FT0112A

*1:   The recording time corresponds with the total time of the continuous-recording and the 
event protection (G detection, Adventure mode, and Surveillance mode).

GENERAL SPECIFICATIONS

Market: Canada




